
Monday, June 14, 2004 
Enhancing Digital Photos with Adobe Photoshop Elements 

Douglas Dixon, Manifest Technology 
 

Digital cameras are great for grabbing images, and consumer photo tools can make it fun to make 
them look better with simple fixes. But what if you want more control and higher quality results for 
enhancing your photos? As we'll demonstrate in this talk, while professionals do the heavy lifting with 
Adobe Photoshop, you can get much of its power packaged in an accessible interface with Photoshop 
Elements, for under $100. 
 
Photoshop Elements provides helpful hints and recipes to guide you through performing common 
photo fixing and enhancements, and then sharing your image in print, in slideshows, or over the Web. 
Plus it also provides access to powerful capabilities from Photoshop, including filters, effects, text, 
graphics shapes, and even layers. You can start with the auto enhancement options, move on to visu-
ally refining your photos, have fun with artistic filters, or drill down to perform photographic manipu-
lations. 
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What would you like to see at a PPCUG meeting?  Your feedback about 
past meetings and your suggestions for future meetings will make sure that 
we continue to present interesting programs that will make you glad that 
you’re a member.  This club exists by volunteer efforts.  If you don’t volun-
teer for anything else, know that offering your comments regarding meeting 
topics is a very important contribution to our success.  Contact any officer. 

Coming Events 
July 12, 2004 - Video editing with free (or nearly free) software 
August 9, 2004 - Computer Security - Joel May 
September 13, 2004 - PC Magazine columnist - Bill Machrone 
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About PPCUG 
 

General Meetings 
Second Monday of the month at the 
Lawrenceville Library, Alternate 
Route 1 and Darrah Lane. 
7:00 PM: Social Time / Tech Corner 
7:30 PM: Meeting comes to Order 
7:45 PM: Featured presentation 
 

For information about upcoming 
meetings or joining PPCUG, see: 
http://www.ppcug-nj.org 
or email us at: 
ppcug@njcc.com (Please 
include “OK” in the subject line.) 
 

Board Meetings  
Board meetings are open to all mem-
bers.  Notice of an upcoming meeting 
will be posted on the web site.   
 

Board Members 
President: 
   Clarke Walker        609-883-5262 
Vice-President: 
   Tom Carman        732-828-6055 
Secretary: 
   Don Arrowsmith      609-883-9874 
Treasurer: 
   Paul Kurivchack      908-218-0778 
Members-At-Large: 
   Al Axelrod        609-737-2827 
   Vic Laurie        609-924-1220          
   Kim Goldenberg      609-631-9140   
   Sol Libes        609-520-9024 
 

Chairpersons 
Hospitality: 
   Bill Hawryluk        609-655-0923 
Member Records: 
   Paul Kurivchack      908-218-0778 
Newsletter Editor: 
   Don Arrowsmith     609-883-9874 
Program Coordinator: 
   Sol Libes        609-520-9024 
Web Master: 
   Don Arrowsmith     609-883-9874 
 

Annual Dues 
Dues are $30 per calendar year with a 
mailed newsletter or $20 per year 
with online access to the newsletter.  
New members pay $2.50 or $1.75 per 
month times the number of months 
remaining in the current year. 

May Meeting Minutes 
It must have been a good computer month for everyone because there were no ques-
tions for the Q&A!  Paul announced that the TCF package pickup area generated $498 
for the PPCUG ($406 donations and $92 profit from beverage sales).  Appreciation 
goes to Paul Kurivchack, Bud Lewis, Ed Weiss, Don Arrowsmith, Marsha Duggins, 
Tom Carman, Clarke Walker, Kim Goldenberg, Kris Maharaj, Bruce Zaborowski, Al 
Axelrod, and Huston Landis for volunteering to work at this fundraiser. 
 
David Soll presented the 
evening’s program on Trou-
bleshooting Windows Prob-
lems.  He divided his talk 
into several sections:  Win-
dows versions, File systems, 
Hardware, Registry, Pro-
grams that start automati-
cally, Task Manager, Re-
store Points, Software up-
dates, DLL Hell, and 
TweakUI.  David can be 
reached at 
dsoll@omicron.com. The 
complete set of Power Point 
slides is available at: http://home.comcast.net/~soll/Troubleshooting_Windows.ppt. 
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Biography for Doug Dixon, our June Presenter 
 
Douglas Dixon is a technologist and author specializing in digital media. His Manifest 
Technology website provides free articles and technical references to help make sense 
of multimedia technology (www.manifest-tech.com). 
 
As a technology writer, Doug has published over 110 feature articles, and is the author 
of three books, including "Desktop DVD Authoring" and "How to Use Adobe Pre-
miere." Among other positions, he is currently editor-at-large for Mediaware maga-
zine, contributing editor for Camcorder and Computer Video magazine, and a con-
tributor to CNET Reviews and the U.S.1 Newspaper. 
 
Doug has presented over 45 seminars and talks in the past few years on digital media 
topics, for professional groups and conferences including Sony Training, NAB, Show-
Biz Expo, DVD International Conference, TECHXNY /PC Expo, and Government 
Video Expo. 
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How to Read E-mail with Greater Safety 
Vic Laurie 

 
Of all the things that can be done with a personal computer, e-mail is probably the 
biggest application for the average PC user. Unfortunately, it is a sad but undeniable 
fact that e-mail is no longer as simple to use as it once was. Between the spammers 
and the malware writers, the life of the e-mail user has been greatly complicated. 
There is even talk that e-mail as we know it is doomed. The writers of malware such 
as viruses and worms have made e-mail the primary choice for spreading their mali-
cious work.  Be that as it may, there are steps that all users of e-mail can and should 
take to defend their computers against this onslaught. 
 
For the most part, the greatest danger in e-mail in the past has been from opening ex-
ecutable attachments containing viruses, worms, Trojans, etc. and I have discussed 
this subject previously (http://www.vlaurie.com/computers2/Articles/defend.htm). 
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Using common sense about clicking on attachments, keep-
ing anti-virus programs and the operating system patches 
up-to-date, and some system configuration should prevent 
infectious attachments from harming your system. With 
increasing frequency, however, the e-mail body itself has 
become a source of infection. By means of HTML code or 
scripts hidden in the text, malware may get downloaded 
simply from the act of opening an e-mail for viewing. It is 
also possible for spammers to track you this way (Web 
bugs, see http://www.eff.org/Privacy/Marketing/
web_bug.html  ). In this article, I will discuss some ways to 
avoid getting malware from the main e-mail body. 
 

Turn off the Preview Pane 
For convenience, many e-mail programs provide automatic 
views of e-mail called the “Preview Pane.” Unfortunately, 
this means that any malicious code in the e-mail body may 
get executed also. Or a signal may be sent to a spammer 
showing that you are reading the message. Steps can be 
taken to help allow safe use of the Preview pane but some 
may prefer to be sure and will want to turn off this feature. 
That way only mail that you deliberately choose to open 
will be displayed. Different e-mail programs will have 
somewhat different procedures for disabling the Preview 
pane but I will give the method for the commonly used 
Windows e-mail client Outlook Express (OE). 
 

Go to the “View” menu, click “Layout” and uncheck “Show 
Preview Pane”. To see this procedure in detail go to a tuto-
rial showing how to configure OE for safety (http://
www.vlaurie.com/computers2/slides/
oeconfigureslide1.htm.) Configuring the Preview pane is 
demonstrated on slides 7 and 8 of this tutorial. Also see 
slide 4 to turn off automatic downloads in the Preview Pane. 
 

Another way of turning the Preview Pane on and off in OE 
uses a sequence of keyboard shortcuts. First hold down 
“Alt” and “v”. This will open the “View” menu. Then in 
succession, press “l” “p” and “Enter.” Note that this is “l” 
for “Layout” and “p” for “Preview Pane”. 
 

I do not use the more complicated application Outlook that 
is part of Microsoft Office but the Outlook feature 
“AutoPreview” (but not “Preview Pane) is safe to use 
(http://www.woodyswatch.com/email/). 
 

Configure system 
The latest versions of OE and Outlook have several security 
measures in place by default but it doesn’t hurt to check. 
Make sure that OE is in the so-called “Restricted sites 
zone”.  Go to the “Tools” menu and open “Options”. Click 
the “security” tab. 
Make sure the radio button is selected next to “Restricted 
site zone…” This procedure is detailed in the tutorial previ-
ously mentioned (see slide 5). 
 

 Read text only 
In order to avoid any hidden HTML or scripts, e-mail can 
be checked out by first reading it in text only. OE has a set-
ting to provide for this. Go to Tools-Options-Read and place 
a check by “Read all messages in plain text”. This will dis-
able all graphics and formatting so it may look a little funny 
but no viruses or spammer’s trackers will be able to run.  If 

a message seems legitimate, the graphics can be turned back 
on.  This procedure is illustrated in slide 4 of the tutorial. 
 

Another way to read an e-mail in text in OE is to right-click 
on the entry in the message list and then select “Properties”. 
Click the “Details” tab (Fig. 1) and then click the button 
“Message Source” (Fig. 2). This method allows for selec-
tively reading messages in text without changing the con-
figuration. If you are interested, this is also the way to view 
the message’s headers. Sometimes the header can help de-
cide whether a message is legitimate. 

Figure 1 "Details" of properties sheet for an email 
 

Figure 2 "Message source" from Details 
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Other e-mail programs may have their own ways to read in 
text only and users of those programs can check the applica-
tion’s help files. 
Reading on the server 
Rather than bringing e-mail to your computer and reading it 
locally with your own e-mail client, you can also read the 
mail in text while it is still on the e-mail server. If your mail 
account is of the usual POP3 variety, the free program Mail-
Washer (http://www.mailwasher.net/) is a handy way to 
check out mail before downloading it. IMAP accounts or 
those with AOL or Hotmail can use the commercial cousin 
($37) MailWasher Pro (http://www.firetrust.com/products/
pro/) 
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Web Links of the Month 
Vic Laurie 

In preparing to teach my April SeniorNet class on Computer 
Safety, I came across the reference below. In light of the 
rash of computer worms, Trojan horses, and viruses that we 
are experiencing, I think the Security Checklist given in the 
reference could be very useful to us all. Some of the items 
(for home networks, for example) may not apply to every-
one, but I think it is a worthwhile list to look at.   
http://www.securityfocus.com/columnists/220  

 

Sol Libes 
Sol recommends this article on using System Restore to 
correct certain serious Windows problems: 
 

http://www.microsoft.com/smallbusiness/issues/
technology/business_software/
how_to_undo_a_big_mistake_in_windows.mspx 
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Are you a Visual Basic Programmer? 
 

You can get a free copy of Visual Basic .NET 2003 for 
watching five short instructional films from Microsoft.  See 
the below announcement from http://msdn.microsoft.com/
vbasic/atthemovies/. 
 

“Welcome to VB at the Movies! The 101 short films below 
will provide everybody from the beginner through the ad-
vanced developer with an opportunity to amp up their VB 
skills. In true studio fashion, we’re releasing two categories 
each week, so check back often to catch the latest releases. 
Let us know what you think! View and rate five movies, 
then sign up to receive your redemption code email entitling 
you to a complimentary Not-For-Resale copy of Visual Ba-
sic .NET 2003 Standard Edition. Grab your popcorn and 
soda, sit back and enjoy! This offer is valid in the 50 United 
States, the District of Columbia, all U.S. military bases that 
contain valid APO/FPO addresses, and Canada.” 
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Getting to Know Google ** 
Billy Mabray, 

Oklahoma City PC Users Group  
 

These days, whether you consciously choose it or not, your 

Web search engine is probably Google (http://
www.google.com). That's because most search sites, 
whether they admit it or not, are powered by Google. And, 
why not? Google rose to the top of the search engines be-
cause its formula provided more relevant search results than 
any other. Also, its deceptively simple page makes it fast 
and easy to use. 
 

I say deceptively simple because, underneath that friendly, 
colorful logo is a powerful search system that can accept 
queries as complex as you want to make them. Many people 
don't realize that if they do not find what they want on the 
first try, there are techniques they can use to improve their 
results. There are also ways to search Google that are more 
appropriate for certain specialty queries. And, Google is 
hiding a few extras that take it beyond a search engine into 
an amazing reference tool. 
 

Let's start with an example. We're cooking dinner tonight, 
and we need a recipe for spaghetti sauce that does not use 
sugar. We might go to Google and type in this: 
 

no sugar spaghetti sauce recipe 
 

Google tells us we have about 56,000 results to wade 
through. A daunting task, considering the first page doesn't 
seem to contain anything relevant. The first thing we will 
try is grouping our search terms into phrases, using double-
quotes. This tells Google that certain words should be 
searched for together. So, we try this: 
 

"no sugar" "spaghetti sauce" recipe 
 

That certainly narrowed things down, didn't it? This is a 
good technique to use when your search contains a lot of 
common words that could appear together in different con-
texts than what you are looking for. Unfortunately in this 
case, our first page of results is still not as relevant as we 
would like. The next thing we will try is searching for pages 
that do not contain a certain term: 
 

-sugar "spaghetti sauce" recipe 
 

This tells Google that we want pages that are about 
"spaghetti sauce" recipe, but specifically do not contain the 
term sugar. That seems to have done it-our first page of re-
sults is chock full of spaghetti sauce recipes that don't use 
sugar. "Subtracting" a term can also be useful when what 
you are searching for has multiple meanings. For example, 
if you are researching the "Holy Grail," you might want to 
add "-Python" to your search to eliminate all the references 
to the movie Monty Python and the Holy Grail. 
 

Now, maybe spaghetti sauce is too specific-we might want 
to also consider marinara sauce. In that case, we use 
Google's or syntax: 
 

-sugar "(spaghetti | marinara) sauce" recipe 
 

When there are multiple words that will satisfy our search, 
we can group them with parentheses and separate them with 
the "pipe" character-a vertical line that is most likely on the 
right-hand side of your keyboard. Google will then search 
for references to "spaghetti sauce" or "marinara sauce." 
 

At this point, we've become so intrigued by what we can 
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find with Google, we've completely forgotten about dinner. 
Now we are interested in just how many different chicken 
casserole recipes we can find. Here's one way: 
 

"chicken * casserole" recipe 
 

Notice the asterisk. This is called a wildcard. It tells Google 
that we don't care what word comes between chicken and 
casserole, but there should be something there. This can be 
particularly useful when you know most of a title of some-
thing, but are unsure of all the words. This particular search 
brings back all kinds of chicken casserole recipes. Some-
thing tells me we better just eat out tonight.  
 

Besides its standard Web search, Google has many specialty 
searches that are triggered either by a keyword or simply by 
what you are searching for. For example: 
 

site:microsoft.com "Internet Explorer" patches 
 

This searches for references to "Internet Explorer" patches 
on microsoft.com only. If your favorite Web site does not 
offer a search function, this is a pretty good substitute. 
 

Maybe we want to know which sites on the Web link to the 
OKC PC User's Group Web site: 
 

link:okcpcug.org 
 

We can also tell Google that what we are looking for is in 
an Adobe Acrobat PDF file: 
 

filetype:pdf refrigerator manual 
 

Google pays attention to what you are searching for, and 
offers helpful services based on what it thinks you want. For 
example, have you ever noticed Google shows your search 
words in the blue bar above your results? The search terms 
that are underlined link to a definition of that word at dic-
tionary.com. If you spell a word wrong, Google will prompt 
you with the correct spelling and ask if you would like to 
search for that instead. 
 

Google has many tricks like this up its sleeves. Search for a 
phone number, and Google will do a reverse lookup on the 
number. Search for a name with a city and state and/or zip 
code, and Google will look up their phone number. Search 
for an address and you will get links to maps of that loca-
tion. Include a zip code with your search terms, and Google 
will offer you local results-Web sites for locations near the 
zip code, ordered by distance. You can even type in a ship-
ment tracking number, and Google will figure out who the 
shipping company is and give you a link to the tracking in-
formation. 
 

Google offers some services that have nothing to do with 
searching. Try this: 
 

68.12 + (68.12 * .2) 
 

The Google calculator will return the result of this computa-
tion. Fun, although, admittedly, not particularly useful. The 
Google calculator can be useful though, for things like con-
versions: 
 

68mm = ? inches 
 

You can do all kinds of conversions using Google-a handy 
tool whenever you get around to making that spaghetti 

sauce. 
 

Google is much more useful than most people realize-we've 
only scratched the surface of what Google can do. If you are 
interested in more, check out Hacking Google by Tara Cal-
ishain and Rael Dornfest. It includes many more search tips, 
and information for programmers who want to include 
Google search results in their applications. As you explore 
what Google can do, you will probably discover that Google 
feels like more than just a Web site. 
 

In fact, Google is your friend. 
 

Billy Mabray and his wife, Angela, own Smart Goat, a local 
software development and web design business.  They are 
members of the OKCPCUG. Comments or questions on the 
article are welcome and can be addressed to:   
billy@smartgoat.com. 
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Whither the Yellow Box? ** 
Moe Norris, Topeka PC Users Club, Kansas 

 

Eastman Kodak Company, an icon in the photographic 
industry for more than 100 years, dropped a bombshell last 
September when it announced that the company would shift 
its focus from film and film-based products to digital 
equipment and processes!  And it has resolutely continued 
down that path.  In January 2004 the company announced 
that by the end of this year it would no longer be selling re-
loadable film based 35mm cameras, including APS models, 
in the U.S., Canada, and Western Europe.  The "throw 
away" (i.e., one-time use) cameras will be the only Kodak 
film camera available in the west.  The number of different 
films provided to retailers will be reduced, concentrating on 
just the most popular lines.  Production of its Carousel film 
projectors was scheduled to cease the end of 2003. 
 

Kodak said that it plans to continue providing 35mm 
cameras in emerging markets, such as China, India, Eastern 
Europe and Latin America, and will introduce six new film 
cameras in those markets this year.  It predicts rapidly 
growing markets for cameras and film in those countries, in 
contrast to what is being seen in the west where the demand 
for film-related products is shrinking much more rapidly 
than anticipated, while purchases of digital cameras 
continue to grow dramatically.  Kodak's array of digital 
cameras now extends from point and shoot consumer 
models to high-end professional (read very expensive) 
digital cameras and camera backs.  It will increase its 
production of inkjet printing papers, and plans to introduce 
a new line of consumer ink jet printer models to go head-to-
head with the well-established offerings from HP, Epson, 
Lexmark, etc. 
 

Kodak's landmark shift in focus represents a profound 
change for the world's largest filmmaker, and a huge 
gamble.  The success of the move remains uncertain.  Just 
when Kodak needs increasing film revenues to underwrite 
the costs (in the billions) of this transition, film sales are 
dropping substantially.  Since 1997 Kodak has reduced its 
workforce by more than 30,000 jobs.  Another 15,000 jobs 
will be eliminated in the next two years in a further effort to 



reduce costs.  Success is not a given.  If fortune does not 
smile on Kodak, then not only may the Yellow Box 
disappear, but the company itself may go down the same 
path-and it won't be a Yellow Brick Road! 
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Charlie’s Tidbits ** 
Charlie Paschal, PPCC 

Don't forget system restore ?  
Viruses are always a threat, but did you know that one can 
"return" without warning if you don't turn off one Windows 
XP feature when cleaning up from a virus? One of XP's 
great features is System Restore that can take your system 
back to a time when it was running better. I've used it 
countless times to return an ill-acting system back to a 
healthy time.  
 

What if, though, you get a virus? Because System Restore 
can contain system settings that will restore the virus itself, 
it should always be turned off before you remove a virus. 
To do that: 
 

Right Click on My Computer and select Properties and left 
click. Click on the System Restore tab and check the box 
labeled "Turn Off System Restore on all Drives." Then, 
clean up the virus and reboot. Don't forget to turn System 
Restore back on after cleaning up the virus. 
 

Hex, binary, Decimal numbers 
 

Princeton PC Users Group 
PO Box 291 
Rocky Hill, NJ  08553 

Ever wonder what people are talking about when they 
mention binary and "hex" numbers? It's the way computers 
"talk" and the language they understand. Our system, of 
course, is the decimal number system, which is 10 base. 
Binary is 2-based, while hex is 16-based. The binary is where 
you get the "1s and 0s" from because that's the only numbers 
used in that system. 
 

For example, the number 11 in decimal is 1011 in binary and 
B in hex. Since 1s and 0s can easily show numbers from 0-9, 
hex is used to represent numbers from 10 through 16, 
meaning at A is 10, B is 11, etc. Because binary numbers can 
get complex, hex is used because it makes it shorter to write 
and it's easier for humans to remember. If you ever want to do 
some conversions yourself without having to learn the 
mathematical way of doing it, use Windows calculator. Go to 
View and select scientific. Plug in a number in decimal and 
then click on Hex or Bin to see the number in that system. For 
example, 999 is 3E7 in hex. In binary it's 1111100111. See? 
You can remember 3E7 but it's not as easy to remember the 
binary version. 
 
 

** There is no restriction against any non-profit group using 
this article as long as it is kept in context with proper credit 
given the author.  The Editorial Committee of the Association 
of Personal Computer User Groups (APCUG), an 
international organization of which this group is a member, 
brings this article to you. 


